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ABSTRACT. Climatic anomalies affect agricultural production, so the identification of climate change at the local level is a
pressing task. The Intergovernmental Panel on Climate Change (IPCC) has generated indices that allow the identification of
extreme climate events. Recent studies of weather and climate variation have increasingly used the climate extreme indices
defined by the IPCC. This article dwells upon the ICC (climate change indicators) software written in the Java language which
is a convenient tool for storing and processing large sets of daily weather data. The software allows the calculation of 27
climate change indices and four indices for growing vines. Built-in analytical tools help identify trends and climate anomalies
on different time intervals. The application is additionally supplied with important functionality for statistical data processing
and visualization. Tools that help analyzing climate change can foster wiser strategic decision-making in the management of
agriculture and ecosystems.
Key words: Analytical tools, climate anomalies, extreme weather, trend analysis, weather data.

RESUMEN. Las anomalías climáticas afectan la producción agrícola, por lo que la identificación del cambio climático a
nivel local es una tarea apremiante. El Panel Intergubernamental sobre Cambio Climático (IPCC) ha generado índices que
permiten identificar los eventos climáticos extremos. En este artículo se trata sobre el desarrollo del software ICC (Indi-
cadores del cambio climático). ICC es una herramienta conveniente para almacenar y procesar conjuntos grandes de datos
meteorológicos diarios. El software permite el cálculo de 27 índices de cambio climático y cuatro índices para el crecimiento
de la uva. Las herramientas analíticas integradas ayudan a identificar tendencias y anomalías climáticas en diferentes inter-
valos de tiempo. El software permite un rápido procesamiento y visualización de datos, es de fácil manejo y tiene una interfaz
intuitiva. El conocimiento sobre el cambio climático puede fomentar una toma de decisiones estratégicas más sensatas en
el manejo de la agricultura y los ecosistemas en general.
Palabras clave: Herramientas analíticas, anomalías climáticas, tiempo extremo, análisis de tendencia, datos del tiempo.

INTRODUCTION

Recent changes in the climate are noted for
a high intensity and frequency (Shelffield and Wood
2011), as well as spatial and temporal heterogeneity.
Specialists predict that climate change will multiply
and amplify hazardous and extreme hydrometeoro-
logical phenomena causing emergencies and natural
calamities (IPCC 2007, Heim 2015). In developing

economies, weather hazards of hydrometeorological
origin are fraught with catastrophic effects for agricul-
ture and food security. Increased frequency and in-
tensity of extreme climate events have serious impli-
cations for socio-economic security and human health
(Sepannen et al. 2006). Since global climate change
is an integral index of regional changes, identification
of the climate change at the local and regional level
is a pressing task. It is there, at local and regional
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scales, that specific measures are taken to mitigate
and adapt to current climate change (Gbegbelegbe et
al. 2014, Jahn 2015, Shannon and Motha 2015).

The World Meteorological Organization (WMO)
declares the priority of studying climate extremes
and taking actions to mitigate the impact of extreme
weather events. Extreme weather events are more
variable. That is why recent studies of weather and cli-
mate variation have increasingly used the derivatives
of climate extreme indices (Karl et al. 1999). The
Intergovernmental Panel on Climate Change (IPCC)
has recommended using a set of indices for extreme
climate events. The indices are calculated from pre-
processed meteorological datasets (IPCC 2007, Pe-
terson 2005).

The known complexities of big data processing
and analysis are labor-intensity, occurrence of in-
complete and inconsistent datasets, and computa-
tion errors (Hall et al. 2009). A possible solution is
to create a software application that can quickly pro-
cess daily temperature and precipitation data covering
large time intervals. Some software products exist
such as RClimDEX, ClimPACT or RclimTool (Zhang
and Yang 2004, Alexander et al. 2013, Herrera 2014)
written in the R language and designed for the com-
putation of climate indices (Alexander et al. 2013,
Herrera 2014). This article dwells upon the ICC (In-
dicators of Climate Change) software written in Java.
The aim was to design and create a software that
fulfills the following tasks for agriculture purposes:
storage of meteorological datasets; calculation of cli-
mate change indices for various time series; calcula-
tion of indices for growing vines; analysis of climate
change trends; analysis of deviations from the mean;
analysis of climate anomalies.

MATERIALS AND METHODS

The ICC software was design conforms to the
NMX-I-045-NYCE standard (SE 2005). The waterfall
life cycle model was chosen. The programming lan-
guage was Java, its benefits being operating system
independence, high productivity, open source code.
Eclipse was used as an integrated development envi-
ronment for writing, testing and tuning modular cross-

platform applications.
Other tools used were: a) Plugins generate

the functionality permitting Eclipse to be optimized for
the development of specific applications; b) Apache
Derby is a 2 MB relational DBMS, owing to JDBC
support Derby can be embedded in any Java-based
solution. Derby DBMS is easy to install, deploy and
use, supports the SQL syntax and the client-server
mode; and c) Database managed by Derby DBMS
was designed and developed to store information
about meteorological datasets.

Equations for the calculation of indices,
correlation and trend analysis were translated to al-
gorithms for processing of the datasets stored in
the DBMS. The results of calculations and analy-
sis are visualized in table or graphics format through
programming interfaces (Figure 1).

Minimum system requirements for ICC opera-
tion: 1GHz or higher Intel or AMD processor; 384 MB
dedicated RAM; VGA display with 1200×800 resolu-
tion and 32 MB video memory; Java virtual machine
(JVM) 1.8; for Windows OS - Windows Vista, 7, 8, 10;
any versions of Linux and Mac OS supporting JVM v.
1.8.

RESULTS AND DISCUSSION

ICC software is installed to the computer by the
setup wizard (ICC.exe file) and the database and the
system are located in a directory (C: ICC:). Once
the installation is complete, a shortcut icon to ICC will
be found on the desktop. ICC software can be run
in English and Spanish, is user-friendly, providing a
graphical environment consisting of a set of screens,
pop-up tabs and icons. ICC main menu additionally
offers a set of common tools such as Save, Copy Cut
and Paste (Figure 2)

The ‘File’ menu provides information about the
weather stations included in the ICC database in
tabular form (Figure 3). Station search can be based
on one or several fields of the table. There are options
to enter data on a new station, as well as edit, dupli-
cate or delete data of a selected station. For entering
a new station, a window will be displayed requesting
the input of general facts about the station (Reference,
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Figure 1. Conceptual diagram of ICC operation.

Figure 2. Diagram functionalities included in the software ICC main menu.

Name, Country, State, and Origin) and its geographi-
cal data (Latitude, Longitude, Altitude).

Activating the ‘Load’ menu one can capture
data on mean, minimum and maximum temperature
and precipitation at selected stations for a given time
interval. Where some values are missing, the system

will run an automatic recalculation from the average
of the data from five days before and five days after
the gap.

The ‘Review’ menu, allow open the window with
daily temperature graphs for the chosen time inter-
val and station, as well as export data in the form of
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Figure 3. Weather station data in the ICC software order by column.

tables or text (.xls and .txt formats) or graphs (.pdf,
.svg, .png formats). The ‘Edit’ menu can be used to
make any changes to the data on mean, minimum
and maximum temperatures and precipitation. There
is also an option to remove a selected range of data.
The ‘Calculation’ menu contains the key functions of
the software. The necessary calculations can be se-
lected from the drop-down tab menu.

ICC performs calculations for 27 core climate
indices defined by IPCC (Karl et al. 1999, Peterson
2005), and an additional index DC40 (Consecutive
days greater than or equal to 40 ◦C) (Bautista et al.
2015). The ‘Calculation’ menu contains the ‘Climate
change indicators’ submenu. Unlike others softwares,
with ICC each index can be calculated for a year- or
a month-long interval or for a specific season (Figure
4). Calculation results are displayed in tables, which
can be saved in the database or exported as .xls or
.txt files.

ICC software unlike others features the func-
tion of calculating agroclimatic indices for growing
vines (Table 1) (Alexander et al. 2013, Herrera 2014).
Four indices are used to analyze the potential of cer-
tain regions for growing vines (Winkler et al. 1974,
Ortiz-Solorio 1987, Gladstones 2002, Snyder et al.
2005). The ‘Grape indices’ submenu of the ‘Calcu-
lation’ menu should be chosen for this purpose.

A climate diagram can display data on the
minimum, maximum and mean temperature and pre-
cipitation for two times intervals to be compared within
a single graph (Figure 5). So far, this function is only
possible in ICC. The data can be exported in graphics,

table or text formats.
ICC allows calculating climate change trends

by analyzing time series, just as other software does,
the difference lies in the use of climate change indi-
cators instead of climate elements (Table 2) (Zhang
and Yang 2004, Alexander et al. 2013, Herrera 2014).
The tests used for this purpose are Mann-Kendall
test, Sen’s test and Pearson correlation coefficient
(Sen 1968, Kendall and Gibbson 1990). The de-
gree of linear relationship between two variables is
usually measured by the Pearson correlation coeffi-
cient. Correlation analysis can be used as a first
approximation to detect changes in climate data and
will work even for discrete data. The Mann-Kendall
(MK) test is a non-parametric rank correlation coeffi-
cient. It is used to identify non-linear trends in ‘non-
Gaussian’ data series sampled at equal time intervals
(Kendall and Gibbson 1990). Where the MK test dis-
plays a monotonous trend which appears linear, Sen’s
slope can be estimated to determine the trend in the
dataset. These tests are robust against outliers, data
gaps (lacunae) and non-normality.

The ‘Trends overview’ menu is useful for saving
analysis time. It enables viewing data tables with
summaries of climate change trends and choosing
the indicators and / or months with changing trends
to plot graphs only where changing trends were iden-
tified. In this menu one can select a range of years or
months within a year for the chosen weather station,
group indices into temperature or precipitation cate-
gories and pick out the necessary ones, run calcu-
lations for the selected time ranges and indices, and
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Figure 4. Annual climate change indicators in the ICC software defined by IPCC.

Table 1. Grape indices.

Designation, Equation Values Origin
units

Growing degree
GDD = ∑ Tm - 10

Tm - average daily Winkler et al.
days, ◦C temperature, ◦C (1974)
Frost-free PLH = -2.009Tioa2 Tioa - average minimum temperature Snyder et al.

period, days +52.658 Tioa + 24.52 for the period from October to April, ◦C (2005)
Cold hours,

HF = 485.1 - 28.52Tm
Tm - average temperature for the Ortiz-Solorio

hours period from November to February, ◦C (1987)
Average Tmax - average maximum temperature Gladstones

maximum TMM = T max i j for the period from April to October, ◦C (2002)
temperature, ◦C i and j - lower and upper analysis interval limit

remove the unnecessary data. The results can be ex-
ported as .xls or.txt files.

Only with the ICC software it is possible to plot
the deviations to the average value of the indicators
of climate change, this function is of great importance
because it allows knowing the increases or decreases
of each indicator of climate change over the years
(Figure 6, Table 2). Graphs for climate indices can be
plotted by opening the ‘Calculation’ menu, choosing
the ‘Graphics of increases and decreases’ submenu
and the item ‘Climate change indicators’Ȧ new tab
will open, where one can choose the weather sta-
tion, time range and index, data visualization options
and then export graphical files in .pdf, .svg, .png for-

mats. By choosing the ‘Grape indices’ item in the
‘Graphics of increases and decreases’ submenu, one
can plot vines growing indices using data from the
chosen weather station.

Another exclusive function of the ICC software
is the identification of the anomalous values in cli-
mate change indicators and in the elements of the
climate (Table 2). The ‘Graphics of the annual /
monthly normal distribution’ menu is used to iden-
tify climate anomalies. This is done by investigating
the difference between the means over the chosen
period and the reference period considered as nor-
mal (usually a period before 1990) (IPCC 2007). Very
high or very low values with 0.01-0.05 probability of
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Figure 5. Climate diagrams of temperatures and precipitation on two periods using the ICC software.

Table 2. Comparison in the operation of the ICC software with other softwares.

Functions ICC RClimTool ClimPACT RClimDex
1 Daily data analysis Yes Yes Yes Yes
2 Analysis of monthly data Yes No No No
3 Developed on R language No Yes Yes Yes
4 Developed on Java language Yes No No No
5 Data persistence (Database) Yes No No No
6 Analysis of data series Yes Yes Yes Yes
7 Calculation of climate change indicators annual Yes Yes Yes Yes
8 Calculation of climate change indicators by monthly, seasonal temporality Yes No No No
9 Climate diagram for one or two time periods Yes No No No
10 Review of temperatures graphically and tabularly Yes Yes No No
11 Interface to modify the captured data Yes No No No
12 Agroclimatic indices for the cultivation of the vine Yes No No No
13 Trend analysis with Mann-Kendall and Sen’s Yes No No No
14 Summary of annual and monthly trends with Mann-Kendall and Sen’s Yes No No No
15 Friendly interface Yes No No No
16 Export tabular data to *.xls, *.txt format Yes No No No
17 Export tabular data to *.csv format No Yes Yes Yes
18 Export of graphic data to *.pdf Yes Yes Yes Yes
19 Data capture based on a template Yes No No No
20 Analysis of data homogeneity (Maximum, average, minimum and precipitation temperature) Yes No No No
21 Analysis of homogeneity from other software (RHTest WMO) No Yes Yes Yes
22 Available in Spanish and English Yes No No No
23 Estimation of missing data Yes Yes No No
24 ENSO conditions (El Niño/Southern Oscillation) No Yes No No
25 BoxPlot graphs and histograms to represent time series No Yes No No
26 Data dispersion graphs (ICC also implements linear regression) Yes Yes No No
27 Analysis of anomalies and extreme annual and monthly events Yes No No No
28 Analysis of deviations from the mean in annual, monthly and seasonal temporality Yes No No No
29 Based on Microsoft Excel No No No Yes
30 Summary of daily to monthly climatic variables for Clic-MD R© Yes No No
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Figure 6. Deviations from the average climate change indicators using the ICC software.

occurrence are deemed abnormal (Beniston 2008).
They correspond to the extremes of the normal dis-
tribution curve. To plot annual or monthly normal
distribution graphs open the ‘Calculations’ menu and
proceed to the corresponding submenu. A new tab
will open, where one chooses the weather station,
first and second reference periods, index and month
to be analyzed. The data can be edited and saved in
.pdf, .svg, .png formats.

The ‘Data summary Clic-MD’ submenu is used
to generate summary tables with data on mean,
minimum and maximum temperatures and precipita-
tion for each month over the given range of years for
the chosen weather station. The contents of the ta-
bles can be exported as .xls and.txt files. The inter-
face language (English or Spanish) can be chosen
through the ‘Options’ menu. The ‘Help’ menu pro-
vides information about the software (name, version,
description), copyright, information about the com-
pany and authors.

ICC software offers a set of tools for storing
and processing large sets of daily weather data. The
software permits the calculation and analysis of 27

climate change indices and four indices for growing
vines. The data can be analyzed over monthly, sea-
sonal and annual time intervals to identify trends and
climate anomalies. Understanding of climate change
can help work out more effective strategies for miti-
gating the effects of extreme events in agriculture and
ecosystems in general.

In comparison with other softwares (RClimTool,
RClimPACT and RClimDex), ICC is friendlier and
contains more functions, besides functioning as a
database (Table 2) (Zhang and Yang 2004, Alexan-
der et al. 2013, Herrera 2014). With this new ICC
software researchers and technicians have a tool to
analyze millions of data in seconds in a friendly en-
vironment and easy to interpret. ICC software might
help in the implementation of mitigation measures for
climate change based on the data of each location.

ACKNOWLEDGEMENTS

A skiu (Acts with science SRL) for the free li-
cense of the ICC software for the elaboration of the
figures (https://www.actswithscience.com/).

DOI: 10.19136/era.a6n17.1770
ISSN: 2007-9028
E. ISSN: 2007-901X

www.ujat.mx/era

349

https://creativecommons.org/licenses/by-nc-nd/4.0/


Bautista et al.
ICC software for computing climate change indices

Ecosist. Recur. Agropec.
6(17):343-351,2019

LITERATURE CITED

Alexander L, Yang H, Perkins S (2013) ClimPact. Indices and software. World Climate Programme, New South
Wales University of Technology. 52p.

Bautista F, Pacheco A, Ayala G (2015) Indicadores de cambio climático con datos diarios. Scientific Knowledge
In Use. México. 59p.

Beniston M (2008) Extreme climatic events and their impacts: examples from the Swiss Alps. In: Díaz HF,
Murnane RJ (ed) Climate extremes and society. Cambridge University Press. New York. pp: 147-164.

Gbegbelegbe S, Chung U, Shiferaw B, Msangi S, Tesfaye K (2014) Quantifying the impact of weather extremes
on global food security: A spatial bio-economic approach. Weather and Climate Extremes 4: 96-108

Gladstones J (2002) Viticulture and environment. Adelaide, Winetitles. Australia. 310p.

Hall M, Frank E, Holmes G, Pfahringer B, Reutemann P, Witten IH (2009) The WEKA Data Mining Software: An
Update: SIGKDD Explorations 11: 10-18.

Herrera LL (2014) RClimTool user manual. Clima y sector agropecuario Colombiano, Colombia 17p.

Heim R (2015) An overview of weather and climate extremes - Products and trends. Weather and Climate
Extremes 10: 1-9.

IPCC (2007) Climate change 2007: the physical science basis. Cambridge University Press, Cambridge, United
Kingdom and New York, NY, USA. 104p.

Jahn M (2015) Economics of extreme weather events: Terminology and regional impact models. Weather and
Climate Extremes 10: 29-39.

Karl TR, Nicholls N, Ghazi A (1999) CLIVAR/GCOS/WMO workshop on indices and indicators for climate ex-
tremes: Workshop summary. Climate Change 42: 3-4.

Kendall MG, Gibson JD (1990) Rank correlation methods, 5th edn. Oxford University Press. New York. 272p.

Ortiz-Solorio CA (1987) Elementos de agrometeorología cuantitativa con aplicaciones en la república mexicana.
Departamento de Suelos, Universidad Autónoma de Chapingo. México. 326p

Peterson TC (2005) Climate change indices. World Meteorological Organization Bulletin 54: 83-86.

SE (2005) Norma NMX-I-045-NYCE-2005 tecnología de la información-software-procesos del ciclo de vida del
software. Secretaría de Economía. Diarío Oficial de la Federación. http://www.dof.gob.mx/nota_detalle_po-
pup.php?codigo=4918519. Date consulted: January 20, 2018.

Sen PK (1968) Estimates of the regression coeficient based on Kendall’s tau. Journal of the American Statistical
Association 63: 1379-1389.

Sepännen O, Fisk WJ, Lei-Gómez Q (2006) Effect of temperature on task performance in office environment.
Lawrence Berkeley Laboratory. https://indoor.lbl.gov/sites/all/files/lbnl-60946.pdf. Date consulted: February
15, 2018.

Shannon HD, Motha RP (2015) Managing weather and climate risks to agriculture in North America, Central
America and the Caribbean. Weather and Climate Extremes 10: 50-56.

Sheffield J, Wood EF (2011) Drought: PastProblems and Future Scenarios. Earthscan, London, p.210.

Snyder RL, De Melo-Abreu JP, Matulich S (2005) Frost protection: fundamentals, practice and economics. FAO.
Rome 272p.

www.ujat.mx/era

350

DOI: 10.19136/era.a6n17.1770
ISSN: 2007-9028

E. ISSN: 2007-901X

https://creativecommons.org/licenses/by-nc-nd/4.0/


Bautista et al.
ICC software for computing climate change indices

Ecosist. Recur. Agropec.
6(17):343-351,2019

Winkler AJ, Cook JA, Kliewer WM, Lider LA (1974) General Viticulture. 4th edn. Berkeley, CA: University of
California Press. 710p.

Yan Z, Jones PD, Davies TD, Moberg A, Bergstrom H, Camuffo D, et al. (2002) Trends of extreme temperatures
in Europe and China based on daily observations. Climate Change 53: 355-392.

Zhang GX, Yang F (2004) RClimDex (1.0) User manual. Climate research branch environment, Canada, Downs-
view, Ontario Canada.

DOI: 10.19136/era.a6n17.1770
ISSN: 2007-9028
E. ISSN: 2007-901X

www.ujat.mx/era

351

https://creativecommons.org/licenses/by-nc-nd/4.0/



